
NI Switches Getting Started Guide
For PXI and SCXI  Switch Modules

This document explains how to install, configure, and set up National 
Instruments PXI and SCXI switch modules. This document covers the 
NI-DAQ 7.0 software relative to NI switch modules. For a more detailed 
explanation of NI-DAQ 7.0, refer to the DAQ Quick Start Guide for 
NI-DAQ 7.0.
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Conventions
The following conventions are used in this manual:

» The » symbol leads you through nested menu items and dialog box options 
to a final action. The sequence File»Page Setup»Options directs you to 
pull down the File menu, select the Page Setup item, and select Options 
from the last dialog box.

♦ The ♦ symbol indicates that the following text applies only to a specific 
product, a specific operating system, or a specific software version.

This icon denotes a tip, which alerts you to advisory information.

This icon denotes a note, which alerts you to important information.

This icon denotes a caution, which advises you of precautions to take to 
avoid injury, data loss, or a system crash.

bold Bold text denotes items that you must select or click in the software, such 
as menu items and dialog box options. Bold text also denotes parameter 
names and information on hardware labels.

italic Italic text denotes variables, emphasis, a cross reference, or an introduction 
to a key concept. This font also denotes text that is a placeholder for a word 
or value that you must supply.

monospace Text in this font denotes text or characters that you should enter from the 
keyboard, sections of code, programming examples, and syntax examples. 
This font is also used for the proper names of disk drives, paths, directories, 
programs, subprograms, subroutines, device names, functions, operations, 
variables, filenames and extensions, and code excerpts.

monospace italic Italic text in this font denotes text that is a placeholder for a word or value 
that you must supply.

FCC/Canada Radio Frequency Interference Compliance

Determining FCC Class
The Federal Communications Commission (FCC) has rules to protect 
wireless communications from interference. The FCC places digital 
electronics into two classes. These classes are known as Class A (for use in 
industrial-commercial locations only) or Class B (for use in residential or 
commercial locations). All NI products are FCC Class A products.
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Depending on where it is operated, this Class A product could be 
subject to restrictions in the FCC rules. (In Canada, the Department of 
Communications (DOC), of Industry Canada, regulates wireless 
interference in much the same way.) Digital electronics emit weak signals 
during normal operation that can affect radio, television, or other wireless 
products.

All Class A products display a simple warning statement of one paragraph 
in length regarding interference and undesired operation. The FCC rules 
have restrictions regarding the locations where FCC Class A products can 
be operated.

Consult the FCC Web site at www.fcc.gov for more information.

FCC/DOC Warnings
This equipment generates and uses radio frequency energy and, if not 
installed and used in strict accordance with the instructions in this manual 
and the CE marking Declaration of Conformity1, may cause interference to 
radio and television reception. Classification requirements are the same 
for the Federal Communications Commission (FCC) and the Canadian 
Department of Communications (DOC). 

Changes or modifications not expressly approved by NI could void the 
user’s authority to operate the equipment under the FCC Rules.

Class A

Federal Communications Commission
This equipment has been tested and found to comply with the limits for a 
Class A digital device, pursuant to part 15 of the FCC Rules. These limits 
are designed to provide reasonable protection against harmful interference 
when the equipment is operated in a commercial environment. This 
equipment generates, uses, and can radiate radio frequency energy and, 
if not installed and used in accordance with the instruction manual, may 
cause harmful interference to radio communications. Operation of this 
equipment in a residential area is likely to cause harmful interference 
in which case the user is required to correct the interference at their 
own expense.

1   The CE marking Declaration of Conformity contains important supplementary information and instructions for the user or 
installer.
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Canadian Department of Communications
This Class A digital apparatus meets all requirements of the Canadian 
Interference-Causing Equipment Regulations.

Cet appareil numérique de la classe A respecte toutes les exigences du 
Règlement sur le matériel brouilleur du Canada.

Compliance to EU Directives
Readers in the European Union (EU) must refer to the manufacturer’s 
Declaration of Conformity (DoC) for information pertaining to the 
CE marking compliance scheme. The manufacturer includes a DoC for 
most hardware products except for those bought from OEMs. In addition, 
DoCs are usually not provided if compliance is not required, for example 
electrically benign apparatus or cables.

To obtain the DoC for this product, click Declarations of Conformity 
Information at ni.com/hardref.nsf/. This Web site lists the DoCs by 
product family. Select the appropriate product family, followed by your 
product, and a link to the DoC appears in Adobe Acrobat format. Click the 
Acrobat icon to download or read the DoC.

Safety Information

Caution National Instruments measurement products may be classified as either 
Installation Category I or II. Operate products at or below the Installation Category level 
specified in the switch module specifications. 

Installation Category1: Measurement circuits are subjected to working 
voltages2 and transient stresses (overvoltage) from the circuit to which they 
are connected during measurement or test. Installation Category establishes 
standardized impulse withstand voltage levels that commonly occur in 
electrical distribution systems. The following is a description of Installation 
(Measurement3) Categories:

• Installation Category I is for measurements performed on circuits not 
directly connected to the electrical distribution system referred to as 
MAINS4 voltage. This category is for measurements of voltages from 
specially protected secondary circuits. Such voltage measurements 

1   Installation Categories as defined in electrical safety standard IEC 61010-1.
2   Working voltage is the highest rms value of an AC or DC voltage that can occur across any particular insulation.
3   Installation Category is also referred to as Measurement Category.
4   MAINS is defined as the (hazardous live) electrical supply system to which equipment is designed to be connected for the 

purpose of powering the equipment. Suitably rated measuring circuits may be connected to the MAINS for measuring 
purposes.
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include signal levels, special equipment, limited-energy parts of 
equipment, circuits powered by regulated low-voltage sources, and 
electronics.

• Installation Category II is for measurements performed on circuits 
directly connected to the electrical distribution system. This category 
refers to local-level electrical distribution, such as that provided by a 
standard wall outlet (e.g., 115 V for U.S. or 230 V for Europe). 
Examples of Installation Category II are measurements performed on 
household appliances, portable tools, and similar products.

• Installation Category III is for measurements performed in the building 
installation at the distribution level. This category refers to 
measurements on hard-wired equipment such as equipment in fixed 
installations, distribution boards, and circuit breakers. Other examples 
are wiring, including cables, bus-bars, junction boxes, switches, 
socket-outlets in the fixed installation, and stationary motors with 
permanent connections to fixed installations.

• Installation Category IV is for measurements performed at the primary 
electrical supply installation (<1,000 V). Examples include electricity 
meters and measurements on primary overcurrent protection devices 
and on ripple control units.

Note Refer to the Specifications document included with the switch module to determine 
the relevant pollution and installation categories.

Related Documentation
The following documents contain additional information about your switch 
module and the APIs used to program them. The documents are available 
in electronic form at Program Files»National Instruments»
NI-SWITCH»Documentation or Program Files»National 
Instruments»NI-DAQ.

• Specifications document for your switch

• NI Switches Help contains technical and programming support for 
your NI switch module and the NI-SWITCH 2.0 API

• NI-SWITCH Quick Reference Guide contains an API overview and 
function/VI overview

• DAQ Quick Start Guide for NI-DAQ 7.0 contains additional 
information about NI-DAQ 7.0, the relationship between Traditional 
NI-DAQ and NI-DAQmx, and a complete list of supported modules

• NI-DAQmx Help contains information about programming your 
switch with the NI-DAQmx API

• NI-DAQmx VI Reference Help
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1. Unpack the Module and Accessories
The switch module is shipped in an antistatic package to prevent 
electrostatic damage (ESD) that can damage several components in the 
module. To avoid such damage when you handle the module, take the 
following precautions:

Caution Never touch the exposed pins of connectors. 

• Ground yourself using a grounding strap or by holding a grounded 
object.

• Touch the antistatic package to a metal part of the chassis before you 
remove the module from the package.

Remove the module from the package and inspect the module for loose 
components or any sign of damage. Notify NI if the module appears 
damaged in any way. Do not install a damaged module in the chassis.

Store the module in the antistatic package when the module is not in use.

2. Verify the Components
Make sure you have the following:

❑ NI-DAQ 7.0 software and documentation package

❑ The Specifications document that ships with your NI switch module

❑ 1/8 in. flathead screwdriver

❑ For development, at least one of the following software packages and 
documentation:

– LabVIEW

– LabWindows™/CVI™

– Microsoft Visual C++

– Microsoft Visual Basic

♦ PXI switch modules require the following:

❑ PXI switch module

❑ PXI chassis or PXI/SCXI combination chassis
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♦ SCXI switch modules require the following:

❑ Controller (NI 4021/4060/4070 or E Series device)

❑ Cable adapter

❑ Cable

❑ SCXI switch module

❑ SCXI chassis or PXI/SCXI combination chassis

3. Install the Software
National Instruments switch modules are packaged with NI-DAQ 7.0. 
This driver software package contains three drivers as well as an extensive 
library of functions and VIs you can call from your application software, 
including LabVIEW or LabWindows/CVI, to fully program your NI switch 
module. The NI-DAQ 7.0 driver software has an application programming 
interface (API), which is a library of functions, classes, VIs, attributes, and 
properties for creating applications for your device.

Insert the NI-DAQ 7.0 CD

Caution NI-DAQ 7.0 cannot exist on the same system with earlier versions of NI-DAQ. 
When you install NI-DAQ 7.0, Traditional NI-DAQ replaces NI-DAQ 6.9.x and earlier 
versions, as well as any support files installed by that earlier version. Older versions of 
NI-DAQ are removed when you install NI-DAQmx. Some NI-DAQ devices supported in 
6.9.3 may no longer be supported. Refer to the DAQ Quick Start Guide for NI-DAQ 7.0 
for details.

Insert the NI-DAQ 7.0 CD. The NI-DAQ 7.0 installer should open 
automatically. If not, select Start»Run. Enter x:\setup.exe, where x 
is the letter of the CD drive. For troubleshooting and operating 
system-specific instructions, refer to the Hardware Installation Wizard 
at ni.com/support/install.

Tip Install your driver software before installing the switch module to ensure proper 
installation and to avoid warnings about driver installation asking you to install the driver.

Note You must use NI application software (LabVIEW, LabWindows/CVI, or 
Measurement Studio) version 7.0 or higher to use NI-DAQmx. The NI-SWITCH API 
supports LabVIEW 6.1 and LabVIEW 7.0 and LabWindows/CVI 5.5 and higher. Install 
or upgrade your application software before installing the driver software.
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Select an API
NI-DAQ 7.0 includes three drivers, each with its own API.

• Traditional NI-DAQ is an upgrade to NI-DAQ 6.9.3 and earlier. 
Traditional NI-DAQ has the same VIs and functions and works the 
same way as NI-DAQ 6.9.3. Traditional NI-DAQ and NI-DAQmx, 
both part of NI-DAQ 7.0, can coexist on the same computer. 

• NI-DAQmx is the latest NI-DAQ driver with new VIs, functions, and 
development tools for programming switch modules as well as 
E Series and other SCXI modules.

• NI-SWITCH 2.0 is the latest NI-SWITCH driver with new VIs, 
functions, and development tools for programming switch modules. 
NI-SWITCH is a driver layer on top of the NI-DAQmx and Traditional 
DAQ drivers. NI-SWITCH is an IVI-compliant instrument driver that 
supports all NI switch modules.

Refer to Table 1 to determine which APIs work with your switch module.

Install Support Files
The NI-DAQ 7.0 installer detects the NI software installed on the system 
and automatically selects the latest versions of the driver, application 
software, and language support files from the CD. You also can select one 
or all of the support file subcomponents for each driver. 

Verify that the installer detected and selected the correct support files and 
the correct version number of the application software and/or language. 
You can select additional options to install the support files, examples, and 
documentation. Follow the software prompts. 

Note If you installed your NI application software after installing NI-DAQ 7.0, relaunch 
the installation program by selecting Start»Run. Enter x:\setup.exe, where x is the 
letter of the CD drive with the NI-DAQ 7.0 CD.

Table 1.  Switch Module API Support

Module
NI-DAQmx 

API
Traditional 

NI-DAQ API
NI-SWITCH 

2.0 API

SCXI-1166 and SCXI-1193 ✓ — ✓

SCXI-1160, SCXI-1161, and SCXI-1163R ✓ ✓ ✓

All other SCXI switch modules ✓ — ✓

PXI-2566 and PXI-2593 ✓ — ✓

All other PXI switch modules — — ✓
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4. Install the PXI Switch Modules
To install a PXI module, complete the following steps:

1. Power off and unplug the PXI chassis. Follow proper ESD precautions 
to ensure you are grounded before installing the hardware.

2. Remove the filler panel of an unused PXI slot. 

3. Touch any metal part of the chassis to discharge static electricity. 

4. Insert the device into the PXI slot. Use the injector/ejector handle to 
fully insert the device. 

5. Screw the device front panel to the chassis front panel mounting rail.

Figure 1.  Installing a PXI Switch Module

1 PXI or PXI/SCXI Combination Chassis
2 PXI Switch Module
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4 Injector/ejector Handle
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5. Install the SCXI Switch Modules

Rear Connectors
SCXI switches have two types of rear connectors that differentiate their 
cabling schemes: a 10-pin and a 50-pin. Refer to Table 2 and look at the 
back of the switch module to determine how many pins are on the rear 
connector.

Figure 2.  SCXI Switch Module Rear Connectors

1 High Voltage Analog Bus (HVAB)
2 10-pin Rear Connector

2 50-pin Rear Connector

32

1



© National Instruments Corporation 11 NI Switches Getting Started Guide

SCXI Controllers
SCXI switch modules require a controller. Before installing an SCXI 
switch module, refer to Table 2 to ensure that your controller supports your 
switch. Table 2 also lists the cable adapter kit(s) necessary to cable the 
controller directly to the switch module.

Installation
After you have installed and configured the controller, refer to the 
flowchart in Figure 3 for your next steps. Refer to the DAQ Quick Start 
Guide for NI-DAQ 7.0 for installing an E Series or NI 4021 device and 
the NI Digital Multimeters Getting Started Guide for installing the 
NI 4060/4070.

Table 2.  SCXI Controllers and Supported SCXI Switches

Rear 
Connector Switch Module

SCXI Switch Controllers

NI 4021 NI 4060 NI 4070 E Series

10-pin SCXI-1127 SCXI-1359 kit SCXI-1357 kit or 
SCXI-1358 kit or 

SCXI-1359 kit

SCXI-1357 kit or 
SCXI-1358 kit or 

SCXI-1359 kit

Can control but not 
cable directly to 
switch module2SCXI-1128

SCXI-1129

SCXI-1166 Not supported1 Not supported1

SCXI-1193

50-pin SCXI-1160 SCXI-1362 kit SCXI-1362 kit SCXI-1362 kit SH6868-EP and 
SCXI-1349

SCXI-1161

SCXI-1163R

SCXI-1190

SCXI-1191

SCXI-1192

1 The NI 4060 and the NI 4070 cannot control the SCXI-1166 or the SCXI-1193 switch modules. For software support 
information refer to Table 3.

2 An E Series device can control these switches when cabled to another SCXI module in the same chassis. The cabled SCXI 
module can be an SCXI signal conditioning device or other SCXI switch module. Alternatively, you can install the E Series 
device in the rightmost PXI slot of a PXI-1010 or PXI-1011 chassis.
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Figure 3.  SCXI Switch Module Installation Flowchart
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Procedure 1: Installing the SCXI Switch in an Existing System
If your SCXI system already has a controller established and the controller 
supports your switch, you can simply add additional SCXI switch modules 
in any available SCXI slots. Refer to Table 2 to determine if your controller 
supports your SCXI switch module.

1. Power off and unplug the SCXI chassis. Follow proper ESD 
precautions to ensure you are grounded before installing the hardware.

2. Remove the filler panel in an unused SCXI slot. 

3. Touch any metal part of your chassis to discharge static electricity. 

4. Insert the switch module into the SCXI slot.

5. Screw the device front panel to the chassis front panel mounting rail.

Figure 4.  Installing an SCXI Switch Module in an Existing System

1 Any New NI SCXI Switch Module
2 Existing SCXI Module

3 Any SCXI Chassis
4 Existing Controller
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Procedure 2: Cable the Controller to the SCXI Switch
If you are using an SCXI-1000/1001 or PXI-1010 chassis, complete the 
following steps:

1. Power off and unplug the SCXI chassis. Follow proper ESD 
precautions to ensure you are grounded before installing the hardware.

2. Set the chassis address switches to OFF. In Figure 5, all switches are 
shown in the OFF position.

Note Older chassis use jumpers inside the front panel, instead of chassis address switches. 
Older chassis also differ in fuses and AC power selection. Refer to the chassis 
documentation for more information.

3. Confirm the correct power settings (100, 120, 220, or 240 VAC).

4. Connect the power cord.

Figure 5.  Chassis Preparation

After you have prepared your chassis, complete the instructions appropriate 
to your controller. Refer to Table 2 to determine if your controller supports 
and connects to your SCXI switch module.

1 Chassis Address Switches
2 Chassis Power Switch

3 Power Settings
4 Power Cord Connector

2

3

1
4
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E Series
E Series devices can directly cable only to switches with 50-pin rear 
connectors. Refer to Table 2 to determine if your switch module has a 
50-pin rear connector.

1. Power off and unplug the SCXI chassis. Follow proper ESD 
precautions to ensure you are grounded before installing the hardware.

2. Remove the filler panel in an unused SCXI slot. 

3. Touch any metal part of your chassis to discharge static electricity. 

4. Insert the device into the SCXI slot.

5. Screw the device front panel to the chassis front panel mounting rail.

6. Attach the SCXI-1349 cable adapter to the rear of the SCXI switch 
module.

7. Screw the cable adapter to the chassis cable adapter mounting rail.

8. Connect one end of the SH6868 cable to the SCXI-1349 cable adapter 
and the other to the E Series device.

Figure 6.  Cabling to an E Series Device

1 SCXI Switch
2 SCXI-1000/1001 or PXI-1010 Chassis
3 SCXI-1349

4 E Series Device
5 SH6868 Cable
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5

4

3
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NI 4021/4060/4070
Complete the following steps based on the rear connector of your switch 
module. Refer to Table 2 to determine how many pins are on the rear 
connector of the switch module.

SCXI Switch with 10-Pin Rear Connector
1. Power off and unplug the SCXI chassis. Follow proper ESD 

precautions to ensure you are grounded before installing the hardware.

2. Remove the filler panel in an unused SCXI slot. 

3. Touch any metal part of your chassis to discharge static electricity. 

4. Insert the device into the SCXI slot.

5. Screw the device front panel to the chassis front panel mounting rail.

6. Attach the SCXI-1359 cable adapter, included with SCXI-1357/1358 
and 1359 kits, to the rear of the SCXI switch module. Ensure that the 
10-pin connector of the switch module, shown in Figure 2, connects to 
the lower right 10-pin connector of the SCXI-1359 (facing the back).

7. Screw the cable adapter to the chassis cable adapter mounting rail.

8. Connect one end of the SH9MD-AUX cable to the SCXI-1359 cable 
adapter and the other to the NI 4021/4060/4070.

Figure 7.  Cabling an NI 4021/4060/4070 to a 10-Pin Rear Connector Switch Module

1 SCXI Switch
2 SCXI-1000/1001 or PXI-1010 Chassis
3 SCXI-1359

4 Controller
5 SH9MD-AUX Cable

or

4

5

1 2

3
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SCXI Switch with 50-Pin Rear Connector
1. Power off and unplug the SCXI chassis. Follow proper ESD 

precautions to ensure you are grounded before installing the hardware.

2. Remove the filler panel in an unused SCXI slot. 

3. Touch any metal part of your chassis to discharge static electricity. 

4. Insert the device into the SCXI slot.

5. Screw the device front panel to the chassis front panel mounting rail.

6. Attach the SCXI-1362 cable adapter to the rear of the SCXI switch 
module.

7. Screw the cable adapter to the chassis cable adapter mounting rail.

8. Connect one end of the SH9MD-AUX cable to the SCXI-1362 cable 
adapter and the other to the NI 4021/4060/4070.

Figure 8.  Cabling an NI 4021/4060/4070 to a 50-Pin Rear Connector Switch Module

1 SCXI Switch
2 SCXI-1000/1001 or PXI-1010 Chassis
3 SCXI-1362

4 Controller
5 SH9MD-AUX Cable

1

2

4

3
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Procedure 3: Controller in the Rightmost PXI Slot
You can control your SCXI switches without additional cabling by 
installing your controller in the rightmost PXI slot of a PXI-1010 or 
PXI-1011 chassis. Refer to Table 2 to determine if your controller supports 
your SCXI switch module. Complete the following steps:

1. Power off and unplug the PXI chassis. Follow proper ESD precautions 
to ensure you are grounded before installing the hardware.

2. (PXI-1010 only) Set the chassis address switches to OFF. All switches 
in the OFF position are shown in Figure 5.

3. Confirm the correct power settings of the chassis (100, 120, 220, 
or 240 VAC).

4. Connect the chassis power cord.

5. Remove the filler panel in an unused SCXI slot. 

6. Touch any metal part of your chassis to discharge static electricity. 

7. Insert the device into the SCXI slot.

8. Screw the device front panel to the chassis front panel mounting rail.

Figure 9.  Controller in Rightmost PXI Slot
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Procedure 4: Controller Not in Rightmost PXI Slot of PXI-1011
If you do not install the SCXI controller in the rightmost PXI slot of the 
PXI-1011 chassis, you can control the SCXI switches using the 
SH9MD-AUX cable. Refer to Table 2 to determine if your controller 
supports and connects to your SCXI switch module.

1. Power off and unplug the PXI chassis. Follow proper ESD precautions 
to ensure you are grounded before installing the hardware.

2. Confirm the correct power settings of the chassis (100, 120, 220, 
or 240 VAC).

3. Connect the chassis power cord.

4. Remove the filler panel in an unused SCXI slot. 

5. Touch any metal part of your chassis to discharge static electricity. 

6. Insert the device into the SCXI slot.

7. Screw the device front panel to the chassis front panel mounting rail.

8. Connect the SH9MD-AUX cable to the rear of the PXI-1011 chassis.

Figure 10.  Cabling the Controller to the Back of a PXI-1011 Chassis

1 PXI-1011 Chassis 2 SH9MD-AUX Cable

 NATIONAL 
INSTRUMENTS

PXI-1011

LOW
VOLTAGE
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AUX
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SCXI
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(front)

(rear)
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INSTRUMENTS

SCXI-1129

1

2
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6. Configure the PXI Switch Modules
In Measurement & Automation Explorer (MAX), configure each PXI 
switch module you installed. Configuring the switch modules in MAX 
establishes the default settings for the switch module. The PXI-2566 and 
PXI-2593 must be configured under NI-DAQmx Devices while all other 
PXI switches are configured under PXI System. 

1. Double-click the Measurement & Automation Explorer icon on the 
desktop to open MAX.

2. Expand Devices and Interfaces. 

3. Check that your PXI switch module appears under Devices and 
Interfaces. 

If your device does not automatically appear, press <F5> to refresh 
the view in MAX. If the device is still not recognized, refer to 
ni.com\support\install for troubleshooting information.

NI-DAQmx
1. Right-click the switch name and select Properties. Be sure to click the 

device name under NI-DAQmx Devices.

Figure 11.  Configuring Switch Modules Under NI-DAQmx Devices in MAX
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2. Configure the module properties.

• (Optional) Select the terminal block/accessory from the 
Terminal Block/Accessory list box.

• Set the default topology of the switch module by selecting a 
topology from the Topology list box.

3. Click OK to accept the changes.

4. You can perform a self-test on switches listed under NI-DAQmx 
Devices. Right-click the switch you want to test. 

5. Select Self-Test to test the selected device. 

6. When the self-test finishes, a message indicates if an error occurred. 
If an error occurs, refer to ni.com/support for troubleshooting 
information.

PXI System
1. Right-click the switch name and select Properties. Be sure to click the 

device name under PXI System.

Note The PXI-2566 and PXI-2593 must be configured under NI-DAQmx Devices

Figure 12.  Configuring Switch Modules Under PXI System in MAX
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2. Configure the module properties.

• (Optional) Select the terminal block/accessory from the 
Terminal Block/Accessory list box.

• Set the default topology of the switch module by selecting a 
topology from the Topology list box.

3. Click OK to accept the changes.

7. Configure the SCXI Switch Modules
In MAX, configure each SCXI switch module you installed. SCXI switches 
can be configured under NI-DAQmx Devices and/or Traditional NI-DAQ 
Devices. Configuring the switch modules in MAX establishes the default 
settings for the switch module. 

Refer to Table 3 to determine your MAX configuration options according 
to your controller. For example, the NI 4021 can control a switch module 
configured under NI-DAQmx Devices or Traditional NI-DAQ Devices. 
The NI 4060 can only control SCXI switch modules configured under 
Traditional NI-DAQ Devices. 

NI-DAQmx
If you are using NI-DAQmx, complete the following steps, as shown in the 
figures, to configure the SCXI chassis and switch module.

1. Right-click NI-DAQmx Devices in the configuration tree and select 
Create New NI-DAQmx Device.

2. Select NI-DAQmx SCXI Chassis and choose the chassis.

3. Select the controller cabled to the communicating SCXI module from 
Chassis Communicator. If MAX detects only one DAQ device, the 
device is chosen by default, and this option is disabled.

Table 3.  Switch Module Configuration in MAX by Controller

Controller
SCXI-1166/1193 Can Be 

Configured Under
All Other SCXI Switch Modules

Can Be Configured Under

NI 4021 NI-DAQmx Devices NI-DAQmx Devices/
Traditional DAQ Devices

NI 4060 — Traditional DAQ Devices

NI 4070 — Traditional DAQ Devices

E Series NI-DAQmx Devices NI-DAQmx Devices/
Traditional DAQ Devices



© National Instruments Corporation 23 NI Switches Getting Started Guide

4. Select the module slot connected to the chassis communicator from 
Communicating SCXI Module Slot.

5. Enter the chassis address setting in Chassis Address. Make sure the 
setting matches the address setting on the SCXI chassis.

6. Select whether or not to auto-detect SCXI modules. If you do not 
auto-detect modules, MAX disables the Communicating SCXI 
Module Slot.

7. Click Save.

Figure 13.  Configuring SCXI Switch Modules Under NI-DAQmx Devices

8. The SCXI Chassis Configuration window opens. The Modules tab is 
selected by default. If you did not auto-detect modules, select an SCXI 
module from the Modules list box. Be sure to locate the module in the 
correct slot.

Figure 14.  Configuring SCXI Switch Modules Under NI-DAQmx Devices
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9. MAX provides a default name for the Device Name field. To change 
the name, click in the field and enter a unique alphanumeric ID for the 
SCXI module.

Note The text in the Device Name column is the name you reference in the NI-DAQmx 
API and is the resource name for the NI-SWITCH API.

10. If you are using a connected accessory, such as a terminal block, select 
it from Accessory.

11. Click Details to configure the switch module options.

12. The switch module configuration window opens. The Terminal 
Block/Accessory tab is selected by default. Select the terminal block 
connected to the switch module from the Terminal Block/Accessory 
list box.

13. Set a default topology from the Topology list box.

Note The SCXI-1127/1128 can connect to the high voltage analog bus (HVAB) during 
scanning. You can configure the switch to automatically connect to the HVAB during 
scanning by clicking an optional check box (not shown) on the previous window.

Figure 15.  Configuring SCXI Switch Modules Under NI-DAQmx Devices
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14. Click the Channels tab.

15. Designate source channels for the topology selected in the Terminal 
Block/Topology tab. You can set different source channels for each 
topology.

16. Designate reserved for routing channels. You can reserve different 
channels for routing in each topology.

17. Click OK.

18. Repeat steps 11 through 17 to configure additional SCXI switch 
modules.

19. If you need to change any chassis settings, click the Chassis tab.

20. Click OK to accept and save the settings for this chassis.

Note You cannot save the chassis configuration until you finish entering module 
information. A message at the top of the SCXI Chassis Configuration window alerts you 
of the status of the configuration. You cannot save if an error appears in the message box. 
If a warning appears in the message box, you can save the configuration.

21. Right-click the chassis name in the NI-DAQ API you want to test 
under Devices and Interfaces.

22. Select Test. If the test fails, a message explains the failure.

Traditional NI-DAQ
If you are using Traditional NI-DAQ, complete the following steps, as 
shown in the figures, to configure the SCXI chassis and switch module.

1. Right-click Traditional NI-DAQ Devices in the configuration tree 
and select Add SCXI Chassis.
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2. Select SCXI Chassis. Click Next.

Figure 16.  Adding an SCXI Chassis in MAX

3. Select the type of chassis. Click Next.

Figure 17.  Selecting a Chassis Type in MAX

4. Select an ID for the SCXI chassis. The ID can be any integer between 
1 and 3,200. Use this ID to identify the chassis in your application.
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5. Enter the chassis address setting. Make sure the setting matches the 
chassis address setting on the SCXI chassis. Refer to the Procedure 2 
section for help locating the chassis address switches. Click Next. 

Figure 18.  Configuring the Chassis ID and Address in MAX

6. Select whether or not to auto-detect SCXI modules. Click Next.

Figure 19.  Auto-Detecting Modules
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7. Select the controller which acts as the communication path between 
the chassis and the computer. Click Next.

Figure 20.  Select the Controller

8. Select the switch module that is cabled to the communication device. 
If the chassis has only one module, NI-DAQ selects the module by 
default.

9. Click Finish to accept the settings.

Figure 21.  Select the Cabled Switch Module
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10. Select the chassis from Devices and Interfaces»Traditional NI-DAQ 
Devices.

11. Right-click a module slot and choose Properties.

Figure 22.  Configuring Switch Modules Under Traditional NI-DAQ Devices in MAX

12. The General tab is selected by default. Choose which controller 
connects to the module from the Connected to list box. Select the 
check box if the DAQ device controls the chassis.

Figure 23.  Configuring Switch Modules Under Traditional NI-DAQ Devices in MAX
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13. Click the Accessory tab (if available). Select the terminal block 
connected to the switch module from the Accessory list box.

Figure 24.  Configuring Switch Modules Under Traditional NI-DAQ Devices in MAX

14. Click OK to accept the settings.

8. Install the Terminal Blocks and Connect Signals
If your module uses a terminal block, complete the following steps:

1. Wire sensors to your switch module or the terminal block. For signal 
connection information, refer to the terminal block installation guide 
or the NI Switches Help for more information. 

Caution Always refer to the Specifications document included with your switch before 
connecting signals. Exceeding specified switch signal ratings can create a shock or fire 
hazard and damage any or all of the devices connected to the switch.

Caution Modules that share a common high-voltage analog backplane derate to their 
lowest common voltage rating, even if they do not connect signals to the backplane. Refer 
to the Derating Modules that Share the HVAB section for more information.

2. Connect the module front connector to its mating connector on the 
terminal block.

3. Tighten the top and bottom thumbscrews on the back of the terminal 
block rear panel to hold it securely in place.
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Figure 25.  Installing a Terminal Block

Derating Modules that Share the HVAB
As a safety precaution, modules that share a common high-voltage analog 
back plane must be derated to their lowest common voltage rating, even if 
they do not connect signals to the backplane. Refer to Figure 2 to determine 
if your switch has an HVAB connector. The following examples 
demonstrate how to derate your modules.

Example 1
SCXI-1000 chassis
SCXI-1359 2-slot backplane adapter behind slots 3 and 4
SCXI-1127 (250 V, CAT II) in slot 4
SCXI-1129 (150 V, CAT I) in slot 3

Both modules share the high-voltage analog backplane and the SCXI-1127 
must not exceed the rating of the SCXI-1129 (150 V, CAT I).

1 Switch Module
2 Thumbscrews
3 Terminal Block

4 Signal Wires
5 Chassis
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Example 2
SCXI-1000 chassis
SCXI-1359 2-slot backplane adapter behind slots 3 and 4
SCXI-1127 (250 V, CAT II) in slot 4
SCXI-1129 (150 V, CAT I) in slot 2

The SCXI-1127 does not share the high-voltage analog backplane with 
the SCXI-1129. Therefore, the SCXI-1127 can operate at the full rating 
(250 V, CAT II).

Example 3
SCXI-1000 chassis
SCXI-1359 2-slot backplane adapter behind slots 3 and 4
SCXI-1127 (250 V, CAT II) in slot 4
SCXI-1190 (30 V, CAT I) in slot 3

The SCXI-1190 does not have a high-voltage analog backplane connector. 
Therefore, the SCXI-1127 can operate at the full rating (250 V, CAT II).

9. Program the Switch Modules
You can operate the switch module in one of three ways: interactively using 
the NI-SWITCH Soft Front Panel, programming using the NI-SWITCH 
API, or programming using the NI-DAQmx API.

NI-SWITCH Soft Front Panel
The NI-SWITCH SFP is an interactive tool that allows you to test the basic 
functionality of the switch, become familiar with its operation, and use it as 
a tool for troubleshooting your applications. All NI switches can be 
operated with the NI-SWITCH SFP.

You can launch the NI-SWITCH SFP from Program Files»National 
Instruments»NI-SWITCH»NI-SWITCH Soft Front Panel.

NI-SWITCH API
The NI-SWITCH API includes a set of operations and attributes that use all 
the functionality of the switch, including configuration, control, and other 
module-specific functions. All NI switches can be programmed with 
NI-SWITCH.

Information about programming with NI-SWITCH is available in the 
NI Switches Help. This document contains measurement tasks, concepts, 
a detailed function/VI reference for NI-SWITCH 2.0, and information 
specific to your switch module.
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For example locations, refer to Programming»Getting Started with 
NI-SWITCH in the NI Switches Help at Program Files»National 
Instruments»Documentation»NI Switches Help.

NI-DAQmx API
You can operate some switch modules with the NI-DAQmx API. 
NI-DAQmx is particularly useful for multimodule scanning operations. 
Refer to Table 1 to determine if you can program your switch with the 
NI-DAQmx API.

Information about programming with the NI-DAQmx API is available in 
the NI-DAQmx Help. Information specific to your switch module is 
available in the NI Switches Help.

For example locations, refer to the DAQ Quick Start Guide for NI-DAQ 7.0. 



CVI™, LabVIEW™, Measurement Studio™, National Instruments™, NI™, ni.com™, NI-DAQ™, and 
SCXI™ are trademarks of National Instruments Corporation. Product and company names mentioned 
herein are trademarks or trade names of their respective companies. For patents covering 
National Instruments products, refer to the appropriate location: Help»Patents in your software, 
the patents.txt file on your CD, or ni.com/patents.

© 2003 National Instruments Corp. All rights reserved.

323131A-01 Apr03
*323131A-01*


	NI Switches Getting Started Guide
	Contents
	Conventions
	FCC/Canada Radio Frequency Interference Compliance
	Determining FCC Class
	FCC/DOC Warnings
	Class A
	Federal Communications Commission
	Canadian Department of Communications

	Compliance to EU Directives

	Safety Information
	Related Documentation
	1. Unpack the Module and Accessories
	2. Verify the Components
	3. Install the Software
	Insert the NI-DAQ 7.0 CD
	Select an API
	Table 1. Switch Module API Support

	Install Support Files

	4. Install the PXI Switch Modules
	Figure 1. Installing a PXI Switch Module

	5. Install the SCXI Switch Modules
	Rear Connectors
	Figure 2. SCXI Switch Module Rear Connectors

	SCXI Controllers
	Table 2. SCXI Controllers and Supported SCXI Switches

	Installation
	Figure 3. SCXI Switch Module Installation Flowchart

	Procedure 1: Installing the SCXI Switch in an Existing System
	Figure 4. Installing an SCXI Switch Module in an Existing System

	Procedure 2: Cable the Controller to the SCXI Switch
	Figure 5. Chassis Preparation
	E Series
	Figure 6. Cabling to an E Series Device
	NI 4021/4060/4070
	Figure 7. Cabling an NI 4021/4060/4070 to a 10-Pin Rear Connector Switch Module
	Figure 8. Cabling an NI 4021/4060/4070 to a 50-Pin Rear Connector Switch Module

	Procedure 3: Controller in the Rightmost PXI Slot
	Figure 9. Controller in Rightmost PXI Slot

	Procedure 4: Controller Not in Rightmost PXI Slot of PXI-1011
	Figure 10. Cabling the Controller to the Back of a PXI-1011 Chassis


	6. Configure the PXI Switch Modules
	NI-DAQmx
	Figure 11. Configuring Switch Modules Under NI-DAQmx Devices in MAX

	PXI System
	Figure 12. Configuring Switch Modules Under PXI System in MAX


	7. Configure the SCXI Switch Modules
	Table 3. Switch Module Configuration in MAX by Controller
	NI-DAQmx
	Figure 13. Configuring SCXI Switch Modules Under NI-DAQmx Devices
	Figure 14. Configuring SCXI Switch Modules Under NI-DAQmx Devices
	Figure 15. Configuring SCXI Switch Modules Under NI-DAQmx Devices

	Traditional NI-DAQ
	Figure 16. Adding an SCXI Chassis in MAX
	Figure 17. Selecting a Chassis Type in MAX
	Figure 18. Configuring the Chassis ID and Address in MAX
	Figure 19. Auto-Detecting Modules
	Figure 20. Select the Controller
	Figure 21. Select the Cabled Switch Module
	Figure 22. Configuring Switch Modules Under Traditional NI-DAQ Devices in MAX
	Figure 23. Configuring Switch Modules Under Traditional NI-DAQ Devices in MAX
	Figure 24. Configuring Switch Modules Under Traditional NI-DAQ Devices in MAX


	8. Install the Terminal Blocks and Connect Signals
	Figure 25. Installing a Terminal Block
	Derating Modules that Share the HVAB
	Example 1
	Example 2
	Example 3


	9. Program the Switch Modules
	NI-SWITCH Soft Front Panel
	NI-SWITCH API
	NI-DAQmx API


